ﬂoat and Co|umns

Hoahng e|emenfs in 2 co|umns |8HOU{Z

Objectives

After successfully completing this lab, you should be able to:

» devise 2 columns layout within a webpage.

+ apply CSS float property to shift elements to the right or left of the containing element.
+ embed a font that is not part of the web-safe font family using the @font-face rule.

» develop problem solving skills by responding all the critical thinking questions.

Figure 1 shows the structure of the webpage you are building, using <div> tags.

<div id="shell”>

<div id="banner”>

</div>

<div id="mid">
<div id="columnLeft’> <div id="columnRight™>

</div> </div>

<div id="rowBottom”>

</div> </div> </div>
Figure 1
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Get Started

Please pay attention to directions and details as you go through this tutorial.

Do not copy and paste the markup syntax at any point.

All your images, Inkburro.ttf font, center.gif, index.html, and myStyle.css doc should be
contained within a single folder, that you will label as “Lastname_Lab#”

If deems necessary, refer to your previous labs.

HTML

1. Open Dreamweaver, create a new HTML file and a CSS file; name and save them as
index.html and myStyle.css respectively.
2. Link the HTML file to the CSS file.
3. Inthe index.html, create a new <div> id tag, and name it “shell.” This <div> tag will act
as a container within your page to enclose all the contents.
*  Go to Dreamweaver Menu, Window > Insert. The insert panel will pop up (Fig 2). Choose HTML.
Beginner - &I
[az] Image
*i Paragraph
[ ~ Heading
Table
Fig 2
Click on Div, the Insert Div panel (Fig 3) will pop up. You will type “shell” in the ID field. Click OK
Insert Div
insert: | At insertion point | v| | v|
Class: |:B
0
Fig 3

Figure 4 shows your code view of the index.html page.

Fig 4
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<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0

Dv
ﬁQ <html xmlns="http://www.w3.0rg/1999/xhtml">
<head>

i <title>Untitled Document</title>

</head>
%
i} <body>
: <div id="shell">
—
=
<
R </div>
=5 </body>

@ </html>

4. Next, follow the same above steps as in (3) to create a
<div> id tag just below the “shell” id. name it “banner.”
Make sure it has a closing </div>.

Place your cursor after the open <div> tag called “shell”
while you are creating the banner <div>.

5. You will create another <div> id, called “mid” for the
content part of the webpage, below the “banner.” This will
act as a sub-container inside the main “shell” <div>. The
“mid” <div> id will also contain two other <div> tags - -
<div id="columnLeft”> and <div id=“columnRight”>, as
shown in Fig 1.

6. (i) You will need to create a <div> tag, “columnLeft”
which resides inside the “mid” <div> tag. Type some
dummy text for now in between the <div> </div>.
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Transitional//EN" "http://www.w3.0rg/TR/xhtmll/DTD/xhtmll-transitional.dtd">

>«
g <meta http-equiv="Content-Type" content="text/html; charset=UTF-8" />

Nt <link href="myStyle.css" rel="stylesheet" type="text/css" />

<body>
<div id="shell">
<div id="banner'"> </div>

</div>
</body>
</html>

<body>
<div id="shell">
<div id="banner"> </div>

<div id="mid">

</div>
</div>
</body>
</html>

<body>
<div id="shell">
<div id="banner"> </div>
<div id="mid">
<div id="columnLeft"> </div>
<div id="columnRight"> </div>
<div id="rowBottom"> </div>
</div>
</div>
</body>
</html>




(i) And create another <div> tag called “columnRight” which also resides within the “mid”
<div> tag. Type some dummy text for now in between the <div> </div>.

(i) Finally, create a <div> tag called “rowBottom” which also resides within the “mid”

<div> tag.

It is important to note the placement of the opening

Note

within the webpage.

and closing <div> of each tag as you construct divisions

Snorkelling

Kauai is the perfect place to snorkel.
Roughly fifty of the 90 miles of
coastline is white sand beach, which
makes for easy ocean access. Top that

“ off with lots of family-friendly spots, as
well as places for those with more experience, and
Kauai is every snorkeler's dream. Also, please be
mindful of the coral reef, as it is a very delicate living
organism. Make sure not to step or walk on the reef,
and do not touch the coral or any of its inhabitants; for
the reef's health, as well as for your own safety. You'll
also want to take a reef safe sunscreen, as traditional
sunscreens damage the reefs.

Lighthouse

Before heading down to the lighthouse parking lot on
the North Kaua'i peninsula, take a moment to stop at the
upper lot and view the lighthouse from the overlook.
Then continue on down to the lower parking lot.
Kilauea Lighthouse is the northernmost point of the
main Hawaiian Islands. The lighthouse was built in
1913 with the largest hand blown clamshell lens in the
world. It was later replaced with a beacon in the 1970's.
The lighthouse is open to look around on the ground
level. Today the lighthouse remains one of
Kaua'i's most popular attractions. Native
vegetation and an informative visitor centergs '\3
attracts thousands of tourists to this site to
bird watch, view the sweeping cliff and
ocean vistas, and revel in Kaua'i's past.

Kauai is an island full of splendor, raw beauty, and culture; an island that represents the true spirit of aloha.

Figure 5 indicates how the final page will appear after you style it using CSS, prior to

completing the critical thinking questions.

Figure 5
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7. We are done building the structure of the webpage. It is time to replace the dummy text
by meaningful content in step 6 (i) and (ii). You will use your own images (image1.jpg and
imageZ2.jpg) for this lab.

8. Content within <div=“columnLeft”’> </div>
() Editimagel.jpg and image2.jpg in Adobe Photoshop at 72 pixels per inch (ppi), and
crop it to the size of 80px by 80px.

(i) In index.html, position your cursor inside your text paragraph to insert image1.jpg.
Go to Insert Menu > Insert > Image
Look for image1.jpg which should be in the same folder as your other doc. See Fig 6.

id="columnLeft"

Snorkelling
src="imagel.jpg" alt="beach" width="80"
height="80" class="imgLeft"
Kauai is the perfect place to snorkel. Roughly fifty
of the 90 miles of coastline 1is white sand beach,
which makes for easy ocean access. Top that off with
lots of family-friendly spots, as well as places for

Figure 6

You will be essentially creating a class tag for

“‘image1.jpg” so that you can target it. The name
that you assign for each <div> is case sensitive.

(ili) We need to create a class and attribute to image1.jpg specifically so that we can target
it using CSS rule. Create a new class <div> for the “image1.jpg” and name it “imgLeft”
The easiest way is to type "imgLeft" inside the img tag:

<img src="image1.jpg” width="80" height="80px” alt="“flower” class="imgLeft”/>

In the CSS section below, you will learn how to float text around image1.jpg.

9. Content within <div=“columnRight”’> </div>

Page 5 of 10



Create a class tag for “image2.jpg” that will
reside inside columnRight <div>

() Repeat the procedure described in step 8 to insert image2.jpg a few lines before the
end of the paragraph (text) within <div="“columnRight”> </div>

(ii) Assign a class="imgRight” to image2.jpg

(iii) Type an indicative name in the img tag for the image2.jpg that you have inserted within
the text, for alt attribute, alt="indicative name.”

CSS

1. Write down a selector for the individual id and class <div> that you have created in
your index.html doc above. After including the CSS properties below, using the CSS
Designer panel, save all and preview your index.html page in a browser. This will help
you understand the function of each rule better.

2. Open your CSS doc called “myStyle.css” to see all the CSS rules. A CSS rule is made
up of a selector and a declaration. You may utilize the CSS Designer panel.

3. Create a CSS rule for the id, shell, with the following properties:

border: solid 1px #000000;
margin-left:auto;
margin-right:auto;
width:800px;

You will import the “center.gif” (middle line) and position it at

the center of the mid <div>, hence the reason we attribute it a
ote "
position of 50% as shown below.
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4. Create a CSS rule for the id, banner, with the following properties:

background-color: #333333;
height:200px;

5. Create a CSS rule for the id, mid, with the following properties:

background-image:url(center.gif);
background-repeat:repeat-y;
background-position:50%;
margin:20px;

6. Create a CSS rule for the id, columnLeft, with the following properties:

float:left;
width:360px;
display:block;

7. Create a CSS rule for the id, columnRight, with the following properties:

float:right;
width:360px;
display:block;

Save ALL (File > Save ALL) and preview your
index.html page in a browser to notice how each rule
changes the appearance of your webpage.
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8. A new property is introduced called clear:both; which is used to eliminate the two
columns float property in the rowBottom section, as shown in Figure 7.

columnLeft columnRight

rowBottom ( *

Figure 7

9. Create a CSS rule for the id, rowBottom, with the following properties:

clear:both;

padding-top: 20px;
padding-bottom: 10px;
background-color: #990;
border-top-width: 2px;
border-top-style: solid;
border-top-color: #000000;

Now you will float image1.jpg to the left and image2.jpg to the

m right of the text, within the paragraph. This is achieved by using
the imgLeft and imgRight <div> class you created.

10. Create a CSS rule for the class, imglLeft, with the following properties:
float:left;

padding-right: 20px;
padding-bottom: 10px;
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11. Create a CSS rule for the class, imgRight, with the following properties:
float:right;

padding-right: 20px;
padding-bottom: 10px;

Save and preview your webpage. (1 point)

Critical Thinking

To obtain full credits, you must complete the following steps below:

(1) In your HTML page, type a text in the banner <div>, within <h1> tags, to provide a title.
(2 points)

« Embed a font that is not located in your web-font library. You will download a font of
your choice from http://www.dafont.com

Make sure to include the downloaded font (with extension .ttf) into the same
working folder. In this example below, we have downloaded the font called
“Inkburro.ttf.” Therefore, you will replace the name ‘Inkburro’ using your own font
name below:

Using the @font-face rule, you will embed the
downloaded font and reference it by an appropriate name.

 Type the following new rule in your CSS doc.

@font-face {font-family: YourFont; font-
weight:100; src:url(*YourFontName.ttf’);}
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http://www.dafont.com

* You have only declared the new @font-face rule above. Now, you will need to target the
title text within the <h1> tags to change its appearance by using the new embedded
font.

+ Create a new contextual rule such that you can target the content within <h1> tags
located within the banner <div>, and add the following property

font-family: YourFontName;
padding-top: 30px;
padding-left:30px;
font-size:48px;

2. Write a rule to change the text in the rowBottom <div> to the following:
font-family to “Helvetica, Arial, sans-serif” and color to "#EGEACO"
(1 point)

3. Apply a background image in the header to replace the dark gray rectangle. You will
need to use a background image that matches the theme and style of the webpage. It is
important for you to carefully edit the image for web in Adobe Photoshop CC to the
appropriate dimension and proportion so that it fits the header accurately. (1 point)

4. Include the three individual social media icons (carefully edited in Photoshop) in the
footer; they should be displayed horizontally as shown below (the arrow and dashed-line
are for illustration purpose only). (2 points)

Australia is one of the most unique countries on this planet with an endless list of things to do.

5. You will essentially type the text contents provided in Figure 5, but replace the two
thumbnail pictures of your choice. (1 point)

6. Transform the layout of the two columns such that the width of the left column is

relatively smaller than the width of the right column. You will need to re-adjust the position
of center.gif, the divisor of the vertical line. (2 points)

Test and verify that your site meets all of the above
s requirements prior to submission.
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